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Running from the Police





By-Matthew Galusha          





 	I was one of those kids in high school who you saw riding around on a moped. Of course, we were all determined to get as much speed out of them as we could; several of us had speed kits, others bought Octane 108. My problem, in addition to weighing nearly 200 pounds, was that I had the station wagon of mopeds. It was a big luxury liner Sebring '88. But I still managed to get her up to 35, the pride of my fifteen year old workmanship. 


 	 Cops didn't like us too much; let's face it, an obnoxious freshman with speedy wheels isn't exactly a wonderful sight. So they cops would follow us around and might even pull us over to scare us-but usually it wasn't a problem.�


One day I was out riding, testing some new thing to make it a little faster. I noticed a train of cars behind me, at the forefront was a genuine P-I-G. I noticed the cop refused to pass me, so I made a left turn into my elementary school. He followed. I headed up throuh the parking lot, towards a path I knew, following a well-traveled shortcut. The police cruiser was not nimble enough to make it through. He put his lights on though and backed out at high speed. Apparently he wans't too enthralled with my evasive maneuver. �








	I headed back towards home, taking a series of backroads and a mountain path until I stumbled upon my backyard. I raced the moped into the garage, shut the door, just in time to see the cop flying by. I'm not sure what the point was, but picture this whole story in a movie. I think it would be rather amusing to see a moped trying to hobble away from a high-speed patrol cruiser. And then actually making it. 


� EMBED Word.Picture.8  ���				


 $350. That's $350 for a machine that could take you anywhere you wanted to go at 20 m.p.h., and make it seem like a good time if there weren't too many hills or big trucks around. $350! I spend about seventy bucks a week these days just on cough medicine and phone calls to the Motorcycle Industry Council, nevermind transportation. 


 	Moreover, the moped was fun to ride--it put you low to the ground with some wind in your hair and moved you through traffic sort of like a motorcycle did. And in a nation delirious about all sorts of moving vehicles and the trappings thereof (truckers and CBs, the Dukes of Hazzard and CHiPs, go-carts and slot-cars) the fun little moped fit right in. Sales jumped from 25,000 in 1975 to 75,000 in 1976 to 150,000 in 1977--and then doubled again in 1978. There were moped articles in every magazine from Newsweek to Glamour. They were popular with men and women, with the young and the old (and the very old, who liked to tool around retirement communities). They were sold in drugstores and newsstands, as well as your more conventional cycle shops, and everyone was back-ordered. Some high schools began to offer Moped Ed courses to eager freshmen. Nick Nolte and Jacqueline Bisset were in a ridiculous moped chase scene in The Deep. Jimmy Carter encouraged us to buy mopeds as part of his energy conservation program. And the Department of Transportation estimated that in the 1980s, America's roads would be covered by two- to three-million mopeds. But the good days didn't last. 


























Body Text - Use this style for the regular text of an article.


Byline - Use this style for the name of the author of an article.


Byline Company - Use this style to type the author’s company.


Sidebar Head - Use this style to type a second-level heading in a sidebar article.


Sidebar Subhead - Use this style to type a third-level heading in a sidebar article.


Sidebar Text - Use this style to type the text in a sidebar article.


Sidebar Title - Use this style to type first-level headings in a sidebar article.


Footer - Use this style to type the repeating text at the very bottom of each page.


Heading1 - Use this style to create headlines for each article.


Heading2 - Use this style to create section headings in an article.


Jump To and Jump From - Use these styles to indicate that an article continues on another page.


Mailing Address - Use this style in a mailing label to type the destination address.


Postage - Use this style in a mailing label to type postage information.


Return Address - Use this style in a mailing label to type your address.


Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.
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FRC Open's the door. 





By-Tim Casey


FRC President 


 	Welcome to the first edition to the Franklin Riding Club Newsletter.Franklin Riding Club was started so that people from all over could come and enjoy riding with others who like to ride and fix mopeds.


 	You may be woundering "Why would I join some club of people I don't know?" Well it offers you a place to exchange storries about experiences and problems that you have had. You have some one to exchange tips about fixing problems that you may encounter. But mostly  the group is to provide people with other people to ride around with each together.


 	Also you may be asking "What's in it for me, I can find my own people to ride around with." Well when you are a member of FRC you get exclusive 





Discounts and membership rates at moped shops all over. For example a great moped shop called � HYPERLINK "http://moped.org/mstore.htm#andover" ��Adover Cycles, LTD.� located in Denver, Colorado is offering FRC Members with great deals such as only $8.00 for a "Speed Sprocket" for both Puch and Tomos mopeds. Also they are offering BiTurbo exhaust for an amazing low price of $88.00 and you get 10% discount on everything else. Now those are some nice people and some great deals. Plus Andover Cycles, LTD. will ship you order anywhere. That is one of the good deals you get when you are a member of FRC. 





       Death of the Moped








  	Among the many sorrows of 1995, America's failure to celebrate the 20th anniversary of the arrival of the moped on its shores probably doesn't rank very high. The oversight is, perhaps, even understandable. With their puny engines, fragile suspensions, and lumpy contours, mopeds were a paean to defensive driving, and as such, seem completely antithetical to what passes for a recreational vehicle today. Yet the moped was beloved. Twenty years ago, it was up there with hot tubs and Studio 54 on the top of the charts--a hallmark of its age. Since then, times have been tough. Even the recent 70s revivals have largely ignored the moped. Unresuscitated, unable to leap Travoltalike into our decade, the moped languishes in the dark recesses of the past, growing ever more obscure, fading like the leisure suit and Ben Gazzara. So quickly, before everyone who remembers the moped joins the Shah in the hereafter, indulge me, and to celebrate it. 





 	The semi-successful marriage of the motorcycle and the bicycle was first performed in gas-starved Europe at the end of WWII. Dubbed the moped (a contraction of the words motor and pedal), 





and basically unregulated, it flourished in the streets of Paris and Rome. The motors were very small (50 cc's max) and of the simple two-stroke variety, so you had to mix the oil and gas yourself. But these spunky vehicles got ungodly mileage (between 100 and 200 miles per gallon). The pedals were used to help start the engine and to assist in hill climbing (although on some models, real hill climbing could be more easily accomplished by getting off the moped and walking). Those chic Europeans seemed to love them. But in America, mopeds were effectively barred by laws that classified them as motorcycles and demanded that they have foot brakes, turn signals, and various other features that they didn't possess. We had to slake our thirst for this kind of machine with motor scooters and electric bikes. We probably didn't even know we had such a thirst. Then in 1974, after a heavy industry lobby, the National Highway Traffic Safety Administration relaxed the safety standards for mopeds. The great American moped markets were open. Laws varied from state to state, but basically, the U.S. moped's maximum speed was set between 20 and 30 miles an hour, and drivers were forbidden to enter major highways. Beyond that, the mid-70s moped laws were pretty lax. Many states didn't require a license, insurance, or registration; some didn't even set a minimum operating age--which was a blessing for eager-to-get-dating 15-year-olds. (The 30 m.p.h. top speed was somewhat elusive, since most models that could achieve that kind of speed tended to shake the fillings out of your teeth when they did it. Yes, these mopeds were slow, and their engines were meek.) 


 	They came from strange-sounding companies at first: Puch, Garelli, Batavus, and Tomos, to name a few. But once the craze was on, many of the big motorcycle manufacturers joined the fray. The Honda Hobbit, introduced in 1978, may have been the quintessential moped in name and appearance (especially name). The consumer appeal was easy to grasp: The moped was cheap, very cheap. Cheap to operate, cheap to buy, and free to insure. You could get a good one for about 
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To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button and then click Create Text Box Link.


Click in the text box where you want the text to flow. (When you move the upright pitcher over a text box that can receive the link, the pitcher turns into a pouring pitcher.)


Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. 


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.


Notes on Linked Text Boxes


The text boxes that you link to must be empty—they cannot contain text.


Linked text boxes must be contained in a single document. You cannot create text box links from one subdocument within a master document to another subdocument. You also cannot split subdocuments that contain linked text boxes belonging to the same article.


If you click Create Text Box Link and then decide you don’t want to link to another text box, press Esc to cancel.


To move between text boxes in an article, select one of the text boxes and then click either the Next Text Box or Previous Text Box on the Text Box Toolbar. (
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Solex


The moped revival is going ahead full speed - I just received the following letter: 


The Solex motorbike, formerly known as the VeloSolex, has now returned to the US. It has not been sold in the US since the 1970's but has returned. The timing of the Solex's return could not be better. Its look and feel is on the cutting edge of today's retro culture. 


Here are some of the interesting traits of the Solex: 


Incredible gas mileage--200 miles per gallon. 


No hassle ownership. The Solex is classified in the United States as a bicycle. In many states, an owner need not have a license or title to own and operate one. 


Very quiet. It operates at just 65 decibels. 


The Solex has a great history. First patented in the 1940's, the Solex "motor-assisted bicycle" has been a best seller throughout the many years. At one time, it was the 2nd best-selling motorbike in the world. Over 10 million bikes have been sold worldwide. 


The Solex is now being distributed in the United States by Solexus, located in Salt Lake City, Utah. Solexus has achieved the sole distributorship of the US. For more information, email us or call 1-800-393-7101 and ask for Spencer. 


�HYPERLINK "mailto:matthews@inconnect.com"��Chris Matthews���HYPERLINK "http://www.solexus.com"��http://www.solexus.com� 
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 	Lawmakers began to consider the safety issues raised when a vehicle with a top speed of 30 m.p.h. mingles with normal traffic (acceleration at stop lights was a big problem). There were some accidents: not as many as with motorcycles, but there were a lot more safety laws for motorcyclists--including helmet requirements. And in a moped accident, the mopeder always seemed to lose. Furthermore, the police became troubled by the fact that mopeds, with licensing optional in most states, were a good means of transportation for people who'd had their automobile licenses revoked. Resulting legislation greatly increased restrictions on the mopeds. Alas, public perception changed too: The novelty wore off, and the moped became wimpy. Sales leveled, then declined, then dropped off the map. By 1985, there were fewer than 12 moped dealers in the country, down from a late 70s peak of several hundred. Moped madness was over. 











BT50 Not coming to America?





The BT50 is rumored to be ready for export at the end of 1998. It is basiclya Motorcycle oriented Moped targeted at upper income collector market. Thismeans a likely retail price at $2000-$2500. There is also a collector TomosMoped in the works which is 20% bigger, hand painted, and numbered in alimited edition run. Pricing should be between the BT50 and Targa Lx. Thesource of this information is informal talks with European Tomos Enthusiasts,other dealers and the importer. The picture on the internet of the BT50 isactualy in the offices of the importer.


 I talked to a local Tomos Dealer and he said the BT50 project is scrapped. Even though it would go 45mph from the factory, The dealer said you could buy a decent used motorcycle for that price.








 	I was on vacation in Paris in the summer of 1957. I was amazed at how many mopeds I saw in the streets. Except for the Whizzer, mopeds were just about unknown in New York. I just had to have one. A friend I met in Paris recommended that I buy a VeloSolex. I went looking for a store that sold them. But this was Paris and it was August. It seemed that everyone was on vacation and all the stores were closed. So just on a chance I went to the VeloSolex factory just outside of town. The factory seemed shut down for vacation but the manager was there, and thank heavens he spoke English. With his help I bought one at the factory export price of $69 us. The only restriction was that I could not use it in France. So he arranged to have it delivered to my ship. In those years traveling by boat was cheaper than flying. I had come to France on the steamship Arosa Sky for $300 roundtrip. When I got back to New York I passed the bike thru customs and rode it home 10 miles to the Bronx. What a marvelous experience. 


My VeloSolex was a heavy duty bicycle with a 2 cycle 49cc engine sitting on top of the front tire. On a level road the top speed was 20mph.


 The gas tank held a pint and 3/4 of a mixture of gasoline and Castrol 2 cycle motor oil. I also had a spare tank that held half a gallon. I averaged 300 miles per gallon. My best trip was from New York to Virginia and back. I traveled 1520 miles in 20 days. I camped each night in the National and State Parks along the way. After a few years the engine broke down. The nearest mechanic that understood the VeloSolex was in Paris. I had the greatest times of my life on my VeloSolex. 


 











Footer toolbar to navigate among headers and footers, insert date or time, or format the page numbers. To change the text in the footer, select it and type your new text. To change the border, click Borders and Shading on the Format menu.


Q:   Can I save a customized newsletter as a template for future editions?


A:   Yes. Type your own information over the sample text and then click Save As on the File menu. Choose Document Template from the Save as type drop down list (the extension should change from .doc to .dot). Save the file under a new name. Next time you want to create a newsletter, click New on the File menu, then choose your template.
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